Manual de nMSXTiles v0.9.4
		Pentacour ( 21 enero 2014)	PipaGerardo( 21 enero 2018 )
Aplicación para Windows, Linux y MAC que funciona como editor de pantallas, tiles y sprites para el Screen 2 y 4 del MSX1 y MSX2 respectivamente.
Más información: http://pentacour.com/nmsxtiles
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[bookmark: h.czds7z42rxl9]Editor de Pantallas y Tiles
[bookmark: h.8qyzuxjisb0i]Inicio rápido
Abrir o crear un nuevo proyecto. En la zona inferior de la pantalla de trabajo están situados los tres bancos de tiles que se utilizan en el screen 2-4 del MSX1-2. Cada tile de los bancos podrá editarse en la parte derecha de la pantalla haciendo doble click sobre su posición en el banco. Con el botón “To Bank” podrá asignarse el tile una vez editado a la posición activa.
[bookmark: h.oj81psel0rxg]Editor de tiles
Está siituado en la parte superior derecha del entorno de trabajo. Corresponde a un tile de 8x8 píxels y nos permite diseñarlo asignando colores al píxel y al fondo, cumpliendo las restricciones de color del screen 2 del MSX1. Además si quieres usar el screen 4 del MSX2 puedes cambiar la paleta de colores pinchando sobre un color con el botón derecho del ratón.
También hay un nuevo menú llamado “Palette” donde puedes salvar, cargar y exportar la paleta de color.
[bookmark: h.1clai68gwhj8]Dibujar y borrar píxels
En la zona de diseño de tiles podremos dibujar píxels o fondo haciendo click con el botón izquierdo del ratón según tengamos activa la opción Foregr o Backgr respectivamente.
Haciendo click con el botón derecho del ratón dibujaremos lo contrario a lo que tengamos seleccionado en  Foregr o Backgr.
Esto quiere decir que si tenemos seleccionado Foregr, con el botón izquierdo dibujaremos píxels y con el botón derecho los borraremos, que en la práctica será colorear el píxel del color que tengamos asignado a Backgr para aquella fila.
[bookmark: h.cfwjvu1n79rs]Elegir colores de píxel y fondo
En la zona de diseño de tiles, en la parte derecha hay un rectángulo más estrecho donde indicaremos el color de píxel y fondo para cada fila de píxeles. Haciendo click en el rectángulo bajo la etiqueta B y luego click sobre un color en la paleta de la zona superior asignaremos ese color al fondo. Si hacemos lo mismo en el rectángulo situado bajo la etiqueta F se asignará para el color de los píxeles.
En el rectángulo estrecho donde asignamos los colores podemos hacer click sobre una posición en concreto para luego hacer click en el color que queramos en la paleta de colores de la zona superior. De esta manera solo cambiará el color del píxel o del fondo para esa fila en concreto según esté debajo de las etiquetas F o B.
Se puede cambiar los colores de la paleta pinchado sobre un color dado con el botón derecho del ratón.
[bookmark: h.42083ody15uf]Espejo Vertical y Horizontal
Pulsar el botón V (Flip Vertical) para hacer un espejo vertical. El botón H (Flip horizontal) para aplicar un espejo horizontal. 
[bookmark: h.isj2ko4azskw]Desplazamiento de píxels
Pulsar el botón L (Shift Left) para desplazar los píxels una posición a la izquierda. El botón R (Shift Right) los desplaza una posición a la derecha.
[bookmark: h.ohxl75ymt299]Reordenar píxels
El botón R (Reorder) cambiará de color los píxels sin modificar el diseño del tile de tal manera que los píxels de color negro queden como fondo (Background).
[bookmark: h.dzixc1ww9x0z]Invertir colores
El botón I (Invert colors) intercambia los colores de píxel y fondo.
[bookmark: h.ahax9d4i4ax8]Borrar diseño del tile
El botón X (Clear) borra el diseño del tile.
[bookmark: h.jzqslyjvhe]Asignar tile al banco de memoria
El botón To Bank asigna el diseño de tile actual a la posición que haya seleccionada en el banco de memoria activo.
[bookmark: h.ryrx3h47xsu8]Obtener tile del banco de memoria
El botón From Bank obtiene el tile de la posición actual del banco de memoria activo y lo muestra en la zona de edición para poder modificar su diseño.
[bookmark: h.2l2rcovhapc1]Banco de tiles
Está situado en la parte inferior de la zona de trabajo. Hay tres pestañas para mostrar los tres bancos de memoria de 256 posiciones cada uno correspondientes a la tabla de nombres del screen 2-4 del MSX1-2.
[bookmark: h.y3pxgyhh1tcc]Trabajar con los tres bancos de memoria o con uno solo
Por defecto están activos los tres bancos de memoria. Igual que el screen 2-4 del MSX1-2, el primer banco tendrá los tiles que se podrán utilizar en el tercio superior de la pantalla. El segundo el tercio del medio y el tercero el tercio inferior.
Si con los 256 tiles de un banco hay suficiente, se puede marcar One Bank Only y solo se trabajará con el primer banco.
[bookmark: h.q59w5rxpen2x]Pasar un tile al Editor de tiles
Doble click sobre el tile a editar o click con el botón izquierdo del ratón y click sobre el botón From Bank de la zona de edición de tiles.
[bookmark: h.2hwmzmygejvf]Copiar un tile a otra posición del banco de tiles
Click con el botón izquierdo del ratón para seleccionar el tile, pulsar Control +C, click con el botón izquierdo del ratón sobre la nueva posición dentro del banco de tiles y pulsar Control + V.
[bookmark: h.kcwqxcrow15f]Cambiar un tile de posición sin variar el diseño de la pantalla
Click con el botón izquierdo del ratón para seleccionar el tile a mover y click con el botón derecho del ratón sobre la nueva posición dentro del mismo banco de tiles. Esta acción intercambiara la posición de los dos tiles y automáticamente modificará los códigos de tile del diseño de la pantalla (Screen) para que éste no cambie.
[bookmark: h.10v61wvs22d3]Agrupar tiles al incio del banco
Con la opción de menú Tiles Tools->Group Tiles se agruparán todos los tiles al inicio del banco activo, a partir de la posición 1 (deja la 0 libre).
[bookmark: h.lzqa3pih74ch]Guardar bancos de tiles
Con la opción de menú Tiles->Save y Save as… se guardan los bancos de tiles.
[bookmark: h.caa3xttac680]Cargar bancos de tiles
Con la opción de menú Tiles->Load se puede cargar un banco de tiles.
[bookmark: h.rz0jfyl4gfqc]Cargar librería de tiles
Con la opción de menú Tiles->Load from library… se puede cargar parte de un banco de tiles e insertarlo en el banco de tiles del proyecto actual. Se debe seleccionar el fichero con los bancos de tiles y el banco a cargar. En X e Y de Subset to Load se puede indicar la esquina superior izquierda del subconjunto de tiles a cargar y en Width y Height el ancho y alto de la selección respectivamente. En Destination se indicará el banco del proyecto actual donde se insertarán los tiles y en X e Y la posición de la esquina superior derecha.
[bookmark: h.szlc6n47t6uf]Exportar datos
Hay cuatro formatos en que exportar los datos para usarlos con nuestro programa:
[bookmark: h.y043m478rday]ASM Data / ASM Data Hexadecimal
Opciones de menú Tiles->Export ASM Data y Tiles->Export ASM Data Hexadecimal. Crea un fichero de texto con la definición de tiles en formato decimal o hexadecimal respectivamente.. Bajo la etiqueta BANK_PATTERN_n con n=1, 2 o 3 está la definición de patrones para el banco n  y para los tiles de 0 a 255.
Bajo la etiqueta BANK_COLOR_n con n=1, 2 o 3 está la definición de los colores de patrones para el banco n y para los tiles de 2 a 255.
[bookmark: h.xaamy7rq26d4]Bin data / Bin data compressed with Pletter
Opciones de menú Tiles->Export bin data y Tiles->Export bin data compressed with Pletter. Crea dos ficheros binarios: uno con la definición de patrones y otro para la de los colores. Pide el nombre del fichero, al que añadirá las extensiones .til  para la definición de patrones y .col para la de colores. Después se puede seleccionar el exportar todos los bancos o un banco en concreto. También se podrá indicar si se exportarán todos los tiles o un subconjunto de tiles.
Si se selecciona la opción compressed with Pletter los ficheros estarán ya comprimidos con el compresor Pletter de XL2S Entertainment. En su web está disponible el código en ensamblador para descomprimir estos datos, una herramientas para comprimir desde la línea de comandos y el código fuento en C++.
[bookmark: h.ehtcel7yel6r]Exportar en formato PNG
Mediante la opción de menú Tiles->Export PNG se crea un fichero gráfico en formato PNG con los bancos de tiles. Si la opción One bank only está marcada solo exporta un banco y el fichero será de 256x64 píxels. Si no está marcada exporta los tres bancos y el fichero será de 256x192 píxels.
Este fichero se podrá modificar con cualquier editor gráfico. Si se respetan los colores exportados y no se introducen nuevos, se podrá importar después directamente a nMSXTiles.
[bookmark: h.id6fg7wrhuwk]Importar fichero en formato PNG
Para importar un fichero en formato PNG previamente exportado con nMSXTiles se utilizará la opción de menú Tiles->Import PNG file created with nMSXTiles.
Si el fichero está creado con otro programa o es una captura se debe construir un “fichero paleta” para iindicar a nMSXTiles la paleta de 16 colores utilizada. Para ello se debe crear un fichero nuevo en formato PNG donde los 16 primeros píxels tendrán los 16 colores utilizados, coincidiendo el número de píxel con el código de color del MSX.
Así, el píxel 1 tendrá el color negro que se haya utilizado en el fichero PNG, el píxel 4 el azul oscuro, el 7 azul cielo, el 13 magenta… Para ello es tan fácil por ejemplo en GIMP como capturar el color magenta del fichero PNG y dibujar un píxel con ese color capturado en el píxel 13 del fichero paleta. Y así con los 16 colores utilizados. 
Con la opción de menú Tiles->Import PNG, primero pedirá el fichero paleta y después el fichero a importar.
Crear plantilla en formato PNG
Con la opión de menú Tiles->Create PNG Palette file se crea un fichero con los 16 colores del MSX utilizados por nMSXTiles. De esta manera se podrá crear un fichero con cualquier programa de dibujo utilizando estos colores y posteriormente se podrá importar directamente a nMSXTiles sin necesidad de indicarle la paleta.
[bookmark: h.dbex6hjdanrs]Editor de pantalla
Está situado en la parte superior izquierda del entorno de trabajo. Aquí se irán colocando los tiles de los bancos de tiles (parte inferior) y mostrará el aspecto que tendría la pantalla en el MSX.
[bookmark: h.yekh2v1bjhg][bookmark: h.3aal60i6lza]Asignar un tile a una posición de pantalla
Haciendo click con el botón izquierdo del ratón en cualquier tile de la zona de bancos de tiles, éste quedará seleccionado. Entonces, cada vez que se haga click con el botón izquierdo del ratón sobre una posición de la pantalla se asignará ese tile a esa posición. 
Hay que tener en cuenta si está activada la opción One bank only o no. Si está activada solo se tendrá un banco de tiles y se podrán usar sus tiles en toda la pantalla. Si no está activada significa que se quiere trabajar con un banco de tiles para cada tercio de la pantalla. Por lo tanto para asignar un tile por ejemplo a alguna posición del tercio superior deberá ser uno seleccionado del Bank 0. Bank 1 si es para el tercio del medio y Bank 2 para el tercio inferior. Si se selcciona uno del Bank 0 y se hace click en alguna posición de pantallla del tercio del medio o el inferior no asignará nada.
[bookmark: h.hlsty3hkj79g]Eliminar un tile de una posición de pantalla
Haciendo click con el botón derecho del ratón sobre una posición de la pantalla asignará el tile que se tenga definido como Bakground, indicado en el cajetín Background Tiles de la zona inferior derecha del área de trabajo. Se podrá definir un tile diferente para cada tercio de pantalla en caso de no estar activada la opción One bank only.
[bookmark: h.zijv6qw86ltb]Copiar selección de tiles
Haciendo click con el botón derecho del ratón y dejándolo pulsado se podrá establecer un área de selección. Al dejar de pulsarlo quedará seleccionada ese área. Con las teclas Control C se indicará que se quiere copiar. Haciendo click en la zona de pantalla donde se quiera copiar y pulsando las teclas Control V se copiará.
[bookmark: h.vpa0mlmcn7sk]Tamaño del mapa de pantallas
En MultiScreen se indicará el número de pantallas de ancho (X) que tiene el mapa en Map Width y el número de pantallas de alto (Y) en Map Height.
[bookmark: h.tsrilcw9s4aa]Seleccionar pantalla a editar dentro del mapa
En MultiScreen, en la parte izquierda indica la pantalla del mapa que está mostrando en coordenadas X, Y.
[bookmark: h.ry8ki5jcd92t]Inicializar pantalla con códigos de tiles de 0 a 254
Con la opción de menú Screen->Fill screen with tiles 0 to 254 asigna automáticamente los códigos de tiles de la pantalla de 0 a 254 tal y como están por defecto en el screen 2 del MSX.

[bookmark: h.7gvk8xgfjex7]Exportar datos
Con la opción de menú Screen->Export Screen se muestran varias opciones para exportar los datos de las pantallas.
En Format se pueden elegir el formato de los códigos de tile que definen las pantallas del mapa, que puede ser:
· ASM data: Fichero en formato de texto con los códigos en decimal.
· ASM data Hexadecimal: Fichero en formato de texto con los códigos en hexadecimal.
· Bin data: Fichero en formato binario.
· Bin data compressed with Pletter: Fichero en formato binario con los datos comprimidos con compresor Pletter de XL2S Entertainment. En su web está disponible el código en ensamblador para descomprimir estos datos, una herramientas para comprimir desde la línea de comandos y el código fuento en C++.
En Files Mode se puede elegir si un fichero por pantalla con la opción One file by Screen, o un fichero con todas las pantallas del mapa juntas como si fuese una única pantalla “gigante” con la opción One file whole Map. En esta última opción, si el mapa consta por ejemplo de 3 pantallas de ancho de 32x24 píxels por 2 de alto, crearía un fichero con los datos como si se tratase de una sola pantalla de 96x48 píxels.
Actualmente Files Mode solo es aplicable al formato binario. 
En Up left corner se puede indicar si exportar toda la pantalla o solo una parte de ésta, indicando en X e Y la posición de la esquina superior izquierda del conjunto de tiles a exportar y en Width y Height la anchura y altura respectivamente de este conjunto.
Pulsando el botón File se elegirá el nombre del fichero donde se exportarán los datos. En el caso de que sea un fichero por pantalla, al nombre la añadirá la posición de la pantalla dentro del mapa con formato -X-Y.
[bookmark: h.qw36zxfz2dx]Exportar en formato PNG
Con la opción de menú Screen->Export map PNG file exporta en formato PNG todas las pantallas en un solo fichero. 
Con la opción de menú Screen->Export screen PNG file exporta en formato PNG la pantalla que está mostrando actualmente.

[bookmark: h.engsdmgy36tt]Editor de Sprites
nMSXTiles viene con un editor de sprites de 16x16 píxels. Se puede trabajar con hasta cuatro conjuntos de hasta cuatro sprites cada uno, donde cada conjunto puede representar un personaje.
[bookmark: h.h5saernoh05w]Crear, cargar y guardar proyectos
Con la opción de menú Sprites->New se creará un nuevo proyecto. La opción Sprites->Load carga un proyecto existente y Sprites->Save / Save as… guarda el proyecto o lo renombra respectivamente.
[bookmark: h.aeb2bb4rroow]Diseñar un personaje/elemento
En la zona inferior del área de trabajo de los sprites se elige el conjunto con el que se quiere trabajar (Sprites set). 
En la zona central se muestra el diseño de los sprites que forman el conjunto seleccionado, que pueden ser hasta cuatro. Cada sprites es un Plane y cada Plane puede tener un color que se le asignará con el combo de colores que hay al lado de cada uno.
Se debe seleccionar con qué Plane se trabajará en el editor. Con el botón izquierdo del ratón dibujará un punto en la zona en que se encuentre el puntero. Con el botón derecho lo borrará. En la parte superior muestra la previsualización del Sprite set. Al seleccionar otro Plane mostrará en la zona de edición los píxels de ese Plane, aunque en la zona superior seguirá mostrando la previsualización del Sprite set con todos los sprites (Planes) superpuestos.
[bookmark: h.jqy1pqsb9ax9]Aplicar espejo Horizontal
Al pulsar el botón H hace un espejo horizontal del Sprite set actual.
[bookmark: h.h96en4bdvmxc]Exportar datos
Con la opción de menú Sprites->Export exporta en fichero de texto los datos de los sprites.
[bookmark: h.g75k75j1smt5]Importar/Exportar ficheros de Polka!
nMSXTiles permite exportar la definición de tiles a un fichero de Polka! y también importar un fichero creado con este programa a los bancos de tiles.
[bookmark: h.n728tvkp0s21]Importar un fichero de Polka!
Con la opción de menú Project->Export Polka! project creará un fichero de proyecto para Polka! con el Bank 0 de tiles.
[bookmark: h.wyocj598kmdm]Exportar a un fichero de Polka!
Con la opción de menú Project->Import Polka! project se podrá importar un proyecto de Polka! substituyendo el Bank 0 de tiles por el que haya en el proyecto importado.
[bookmark: _GoBack]Nuevo en la versión 0.9.3
· Permite importar y exportar SC2.
· Arreglado fallo en la exportación de screen en pletter.
[bookmark: h.cmv0ipn29ypx]Nuevo en la versión 0.9.1
· Ahora se puede cambiar los colores de la paleta pinchado con el botón derecho del ratón.
· También se puede salvar, leer y exportar la paleta.
· Se puede dibujar en el editor de Tiles y de Sprites manteniendo pulsado uno de los botones del ratón.
· Actualizado el código a QT5 y quitados los “deprecated” y las clases “STL” de C++
Nuevo en la versión 0.8.2
(Las tareas numeradas están en https://code.google.com/p/nmsxtiles/issues/list )
· Corregida tarea 4: La opción de cambiar de posición un tile en un mismo banco sin que modifique el diseño de la pantalla ya funciona correctamente.
· Añadida funcionalidad tarea 5: Se ha añadido una opción para poder exportar a PNG la pantalla actual o todo el mapa.
· Corregida tarea 6:Los proyectos de sprites se cierran correctamente.
